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Chapter 1
Product Description

DocumentumWeb Development Kit (WDK) applications support multiple languages. The installation
of a WDK-based application, such as Webtop, Web Publisher, portlets, and Digital Asset Manager
provides default support for English. Additional language support is provided through the use of
language packs.

A language pack is a language specific archive file that consists of graphical user interface (GUI)
and user documentation that has been localized (translated) into a language other than the
default language, which is US English. However, not all localized products contain localized user
documentation. For complete details on what is localized within each language pack, see Table
1–1, page 10.

To add support for a particular language, the contents of a language pack must be installed to the
appropriate destinations within a WDK application installation. Users can install one or more
language packs directly on top of the core product (US English).

Language Pack Manager (LPM) is a standalone executable that installs language packs for a specific
application server. Once you have downloaded LPM you can download and install language packs
for any supported language. LPM can only be used with version 5.2 or later language packs.

You must install the LPM version for your platform. Each supported platform will have a LPM
executable file that you will use to install language packs. For this 5.3 SP2 release, LPM 5.3 SP2 is
used for 5.3 SP2 WDK-based application language packs, except for PDF Annotation Services
language versions.

Documentum provides language packs in French, Italian, German, Spanish, Japanese, Korean
(FIGSJK), and Swedish. For any other languages, qualified international Documentum partners can
use the Localization Kit to create their own language packs. Currently WDK-based applications do
not support languages that are written right-to-left.

This document includes information for Webtop, Web Publisher, Web Development Kit for Portlets,
Documentum Compliance Manager, Digital Asset Manager, PDF Annotation Services, Application
Connectors, and Documentum Client for Outlook in French, Italian, German, Spanish, Japanese,
Korean (FIGSJK), and Swedish. Following is a table outlining the WDK-based applications and
their available localizations.

Note: Swedish is currently only supported with:
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• Webtop 5.3 SP1, 5.3 SP2
• Web Publisher 5.3 SP1, 5.3 SP2
• Application Connectors 5.3 SP2
• Documentum Client for Outlook 5.3 SP2

Table 1-1. Localized releases for WDK-based applications

Localized Product User Interface Online Help and
User Guide PDF

Workflow Manager
Online Help and
User Guide PDF

Webtop Localized 5.3 SP2 Localized 5.3 SP2 Localized 5.2.5 SP1
except Swedish.

The Swedish
locale uses English
documentation.

Application
Connectors
(included in
corresponding
Webtop, Digital
Asset Manager, and
WDK for Portlets
Language Packs)

Note: The Swedish
locale applies to the
Webtop integration
only.

Localized 5.3 SP2 Localized 5.3 Localized 5.2.5 SP1
except Swedish.

The Swedish
locale uses English
documentation.

Web Publisher Localized 5.3 SP2 Localized 5.3 Localized 5.2.5 SP1
except Swedish.

The Swedish
locale uses English
documentation.

Digital Asset
Manager

Localized 5.3 SP2 Localized 5.3 SP2 Localized 5.2.5 SP1

PDF Annotation
Services

Localized 5.3 SP2 N/A N/A
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Localized Product User Interface Online Help and
User Guide PDF

Workflow Manager
Online Help and
User Guide PDF

Web Development
Kit for Portlets

Localized 5.3 SP2 Localized 5.3 SP2 N/A

Documentum
Compliance
Manager

Localized 5.3 SP2 Localized 5.3 SP2 Localized 5.2.5 SP1

Documentum
Client for Outlook

Localized 5.3 SP2 Localized 5.3 SP2 Localized 5.2.5 SP1
except Swedish.

The Swedish
locale uses English
documentation.

You can create your own language packs, as explained in product localization guides.
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Chapter 2
New Features and Changes

This section lists new features in Language Pack and Language Pack Manager.

New features for version 5.3
1. Upgrade from 5.2.5 SP3 to 5.3 for Webtop, Web Publisher, PDF Annotation Services

and Digital Asset Manager language packs

2. Introduction to PDF Annotation Services in French, Italian, German, Spanish,
Japanese and Korean in multi-lingual build together with English version.

New features for version 5.3 SP1
1. Upgrade language packs

The following application language packs have been upgraded from 5.3 to 5.3 SP1
Webtop, Web Publisher, and Digital Asset Manager.

2. New language packs for portlets

The following application language packs are new for 5.3 SP1 Web Development Kit
(WDK) for Portlets/Documentum Portlets and Web Publisher Portlets.

3. New language packs for Documentum Compliance Manager and Documentum
Submissions Manager.

4. Swedish is now supported for Webtop and Web Publisher applications and language
packs for SP1.
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New features for version 5.3 SP2
1. Upgrade language packs

All 5.3 SP2 supported localized application language packs have been upgraded
from 5.3 or 5.3 SP1 to 5.3 SP2.

2. Swedish is now supported for the Application Connectors application and language
pack for SP2.

The Swedish locale is only supported with the Webtop integration of Application
Connectors. If you are using Digital Asset Manager or WDK for Portlets the
Application Connectors integration is only supported for FIGSJK.

New features for DCO version 5.3 SP2
1. New language packs for Documentum Compliance Manager (DCO)

For information on core English application features for this release, refer to the English
release notes for your WDK-based application.

Changed features from version 5.3
There are no changed features in this release

Changed features from version 5.3 SP1
1. Existing language packs

The Web Publisher Portlet Builder feature is not localized, but the existing Web
Publisher 5.3 SP1 language packs are supported with this Web Publisher Portlet
Builder 5.3 SP1 release.

For information on core English application features for this release, refer to the English
release notes for your WDK-based application.
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Changed features from version 5.3 SP2
There are no changed features in this release
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Chapter 3
Fixed Problems

This section identifies problems and limitations, documented in the release notes of the applicable
minor version release or prior service pack(s), that have since been resolved.

Within two weeks of a release we post a more comprehensive list of fixed bugs on the CustomerNet
support site (http://softwaresupport.emc.com/support). You must have a software support agreement
to log in and access this list of fixed bugs.

WDK Applications common xed bugs
This section lists fixed bugs that affect all localized WDK applications that affect all
languages unless otherwise noted.

Inconsistent online help launches (80370)

The online Help in some applications such as Workflow Manager does not launch when
you click the Help button on the main page, or any context sensitive Help link.

Workaround: Set the character encoding to Western European.

Help links broken on some pages (97708, 74049)

The context-sensitive Help link may be broken in some Web Publisher, Webtop and
Digital Asset Manager pages. For example, Start Workflow, New Content, Import File
Selection, New Cabinet, New Folder, New Document, Select Permission Set, Set Access
or Permission, Category, and Add Files.

Some online help links may also be broken in third-party products.
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You can access the Help contents for these pages using the online Help table of contents.

Properties page truncation of name eld (77114)

The Properties page Name field is truncated if more than 255 bytes are entered in the
filename using accented or double-byte characters.

Web Workfow Manager UI is partly corrupted and partly
in English (96324)

When you try to create a new workflow template using Macintosh OS or Windows 2000
Japanese, the UI has English & partly corrupted Japanese strings.

Workaround: Double click on the activity to view the text label/caption in the Activity
Inspector dialog.

Broken help link in online help (80187)

The Creating a Form online Help link in the Webtop help does not work.

Workaround: Access this topic from the user guide PDF.

Advanced Search page displays the property search
expression in English (96469)

In the Macintosh and Windows OS, when you try to perform an advanced search, the
Search page displays the property search expression in English. The text is not localized.

Webtop xed bugs
This section lists fixed bugs specific to Webtop.
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Rendition opens in the same browser window as
Webtop (110085 and 96304)

If the default setting Reuse Windows for Launching Shortcuts is checked in Internet
Explorer the existing window is used to launch the renditions. To launch a rendition in
a new window, uncheck the Reuse Windows for Launching Shortcuts option on the
Advanced tab under Tools > Internet Options. Unchecking this option forces a new
instance of an Internet Explorer window to open whenever a URL is launched.

Web Publisher xed bugs
This section lists fixed bugs specific to Web Publisher.

Corrupted characters in Rules Editor and Web Publisher
Editor (74189)

On a Solaris\Oracle 9i installation, accented and double-byte characters are corrupted
in Rules Editor and Web Publisher Editor. Characters are not corrupted on a Windows
BEA 8.1 installation on the same client and same browser.

The reason is that Java assumes the properties files are in 8859-1 encoding. If the
characters cannot be displayed in this encoding, Unicode escape is used.

Documentum Compliance Manager xed bugs
This section lists fixed bugs specific to DCM.

Access Help on the main page (103155)

Launching Help from the main page causes a 404 error. To access the Help pages,
provide the following URL either in the running browser or another browser window.

http://<host>:<port no>/dcm/help/<lang_code>/<default.htm>

Where:

<host> is the server name or the IP address where the product is installed
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<port no> is the port number

<lang_code> is the language code such as fr_FR, it_IT, de_DE, es_ES, ja_JP, ko_KR

The strings in the object type drop down of audit trail
report page is not localized (107290)

The strings in the object type drop down should be localized but are not.

PDF Annotation Services xed bugs
This section lists fixed bugs specific to PDF Annotation Services.

Unable to annotate or comment a PDF if accented
characters are in username (80550)

If you log in to Webtop with a user name containing accented characters, a generic error
is generated in the Review Manager Server. You will be unable to annotate or comment
an imported PDF document.
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Chapter 4
Environment and SystemRequirements

This chapter lists the hardware (machine) requirements and software versions supported with
this release. Machine resources, non-Documentum software components (Operating System, Java
Runtime Environment, and so forth), and other Documentum products determine the unique
environment for each Documentum product. Hardware requirements, page 21 addresses basic
machine resource requirements. Software requirements, page 23 addresses specific software versions
that are required for the installation platform.

WDK-based applications operate on a browser client (see Table 4–2, page 23), an application server
(see Table 4–3, page 27), and sometimes a Content Server (see the Content Server Release Notes). Some
applications such as Documentum Web Development Kit for Portlets also operate on a portal server
(see Table 4–7, page 38), and Documentum Client for Outlook (DCO) operates on a Microsoft Outlook
client and an application server.

When the supported environments for the browser client, application server, portal server, Outlook
client and/or Content Server are the same, they can be on the same machine. Otherwise, they need to
be on different machines. When the supported environments for the browser client and application
server are the same, they can be on the same machine. Otherwise, they need to be on different
machines.

Hardware requirements
This section lists nominal machine resources required for product installation and use.
Your individual machine requirements will vary depending on factors such as the
number of products installed, size of your deployment, number of users, and network
latency. The Documentum System Sizing Guide provides an in-depth analysis of system
sizing requirements for implementation and deployment of Documentum systems.
The Documentum System Sizing Tool dynamically generates estimates of your hardware
resource requirements based on your user and hardware profile.

You can download the Documentum System Sizing Tool from the
CustomerNet Web site (http://customernet.documentum.com/developer/
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downloads/DCTMSystemSizingTool.zip) or click the following hyperlink:
DCTMSystemSizingTool.zip

Browser machine requirements

For WDK-based client applications, you need a client machine capable of running the
supported browser configurations listed in Table 4–2, page 23, plus whatever disk
space, RAM, or CPU requirements that may be specified by third-party products such
as Microsoft Office.

WDK-based client applications may install applets and a JRE on the browser client
machine. This will require approximately 25 MB of free hard disk space. Additionally,
you will need sufficient free disk space to handle checked-out and cached documents.

Portal server machine requirements

Web Development Kit for Portlets, and the Web Publisher Portlet Builder feature do not
require any additional hardware on the portal server machine beyond what is required
by the portal server vendor.

Application server machine requirements

The following table provides nominal resource requirements for a localized WDK-based
application, except portlets, on an application server machine.

Table 4-1. Application server machine requirements

Hard Disk Space* RAM** CPU

600 MB 1 GB 800 Mhz (minimum),
1 GHz or greater
(recommended)

* You must also have sufficient free disk space to handle temporary content transfer
files, which can vary substantially from one enterprise to another.

** The amount of RAM that is available after taking into consideration all other RAM
utilization requirements.
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Software requirements
This section provides information on supported software environments.

The tables in this section reflect the latest version(s) of third-party products,
upon which the Documentum product depends, that are supported at the
time of this release. Version(s) of third-party products supported with prior
service packs and the 5.3 base release are also supported with this release. For
information on currently supported environments and future updates, refer to
Product Information System on the Documentum Technical Support web site:
http://softwaresupport.emc.com/support/productinfo/dmProductList.asp?option=2.
For detailed information about the policies governing supported products, refer to
the ESG Customer Guide available on the Documentum Technical Support web site:
http://softwaresupport.emc.com/wcmprodData/sppt_svcs/ESG_Customer_Guide_
Support.pdf.

Browser environment

The user interface for WDK-based clients runs in a browser environment. The browser
environment consists of a specific combination of operating system, browser, and JRE
(except portlets which do not use a JRE). The following table lists the supported browser
environments for WDK-based clients.

Table 4-2. Browser environment

Browser Operating System Java Plug-in

Firefox 1.0.7 MacOSX 10.2.8w/ Security
Update 2005–001

Apple Java 1.3.1 Update 1

Mac OS X 10.3.9 Apple Java 1.3.1 Update 1

Mac OS X 10.4.3 Apple Java 1.3.1 Release 2

Solaris 8 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Solaris 9 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Solaris 10 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5
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Browser Operating System Java Plug-in

Windows 2000 SP4 Update
Rollup 1

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Windows XP SP2 (32-bit
version)

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Windows Server 2003 SP1
(32-bit version)

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Internet Explorer 6.0 SP1 Windows 2000 SP4 Update
Rollup 1

Sun JRE 1.4.2_09

MS JVM 5.0.0.3810

Sun J2SE 5.0 Update 5

Windows XP SP2 (32-bit
version)

Sun JRE 1.4.2_09

MS JVM 5.0.0.3810

Sun J2SE 5.0 Update 5

Windows Server 2003 SP1
(32-bit version)

Sun JRE 1.4.2_09

MS JVM 5.0.0.3810

Sun J2SE 5.0 Update 5

Netscape 7.2 Windows 2000 SP4 Update
Rollup 1

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Windows XP SP2 (32-bit
version)

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Windows Server 2003
(32-bit version) SP1

Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

MacOSX 10.2.8w/ Security
Update 2005–001

Apple Java 1.3.1 Update 1

Mac OS X 10.3.9 Apple Java 1.3.1 Update 1

Mac OS X 10.4.3 Apple Java 1.3.1 Release 2

Mozilla 1.7.12 Solaris 8 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5
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Browser Operating System Java Plug-in

Solaris 9 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Solaris 10 (SPARC) Sun JRE 1.4.2_09

Sun J2SE 5.0 Update 5

Safari 1.3 Mac OS X 10.3.9 Apple Java 1.4.2 Update 2

Safari 2.0.2 Mac OS X 10.4.3 Apple Java 1.4.2 Update 2

Apple Java J2SE 5.0 Release
1

Exceptions

Unless otherwise notes:
• For Internet Explorer with Microsoft JVM, applet-based content transfer is not

supported for Korean or Japanese browsers.
• For Internet Explorer with Microsoft JVM, the following are not supported: Japanese

and Korean operating systems, XML application functionality, and UNICODE-safe
operations.

• Only English Mozilla browsers are supported with Documentum products. You can
run localized Documentum products on English Mozilla browsers.

• Only English Netscape browsers are supported with Documentum products. You
can run localized Documentum products on English Netscape browsers.

• For WDK-based applications with Collaborative Edition enabled, the Rich Text
Editor is not supported for Safari browsers. The Rich Text Editor (RTE), which is
used for creating and editing Rich Text associated with some of the collaboration
features (such as Notes, Folders with Descriptions, Rooms, Comment Threads), does
not support the creation of rich text for Safari versions 1.2.3 and 1.3. Safari users can
create or edit plain text in the RTE, and they can view rich text which has been
created via other browsers, but will not be able to create or edit rich text in the RTE.

• With Collaborative Edition enabled, the Rich Text Editor’s spell-check feature is only
supported on Windows. It also requires Microsoft Word on the client machine.

• The following drag and drop features are only supported on Internet Explorer
browsers running on Windows operating systems:

— dragging files from the Windows file system into the Webtop browser

— dragging files from the Webtop browser to the Windows file system
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• If you licensed the Web Publisher Portlet Builder feature, then only Internet Explorer
browsers on Windows operating systems are supported.

Notes

Unless otherwise noted:

• UCF content transfer mode requires Sun JRE 1.4.2 or higher on the client machine. If
this JRE is not present, the application will attempt to install a private copy of the JRE.

• For Windows XP SP2, you must either disable its built-in popup-blocker, or you must
add the application server as a trusted site.

• Netscape 7.x can only use the built-in Java of Mac OS X which is Java 1.3.1.
• Apple Java 1.4.2 is a port from Sun JDK 1.4.2_05; bundled with Mac OS X or available

from Apple’s Software Update.
• For Mac OS X client machines, install the "Java Update for Mac OS X 10.3.9"

update after installing the Mac OS X 10.3.9 Software. You can download the Java
update from the following URL: http://www.apple.com/support/downloads/
javaupdateformacosx1039.html

• We support 100% Intel compatible processors. Customers will have to obtain
the 100% compatibility statement and guarantee/assurance from the processor
and operating system vendors and log bugs directly with those vendors if any
compatibility issues are discovered.

• Forward proxy support requires Java plug-in version 1.4 or higher. Forward proxy
does not work with Java plug-in version 1.3.1.

• You must enable cookies in your browser.
• PDF Annotation Services supports the following Adobe versions:

— Adobe Acrobat 6.0.3

There is no Korean version of Acrobat Professional 6.x so English version should
be used instead.

— Adobe Acrobat 7

— Adobe Acrobat Reader 7

Adobe LiveCycle Reader Extensions are required if users want to annotate using
Adobe Reader 7.0.

• PDF Annotation Services does not include DFC in its installer or .war file. You must
install DFC separately and deploy PDF Annotation Services on top of DFC. PDF
Annotation Services requires the same version of DFC as the current version of
Webtop.
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Application server environment

WDK-based applications, except portlets, run in an application server environment. The
application server environment consists of a specific combination of operating system,
application server, and JDK. The following table lists the supported application server
environments for localized WDK-based applications, except portlets.

Table 4-3. Application server environment

Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

BEA WebLogic
Server 8.1
SP4 & BEA
WebLogic
Express 8.1 SP4

AIX 5L V5.2
ML6

Power IBM SDK 1.4.2 No

AIX 5L V5.3
ML2

Power IBM SDK 1.4.2 No

HP-UX 11i
version 2
Update 2
(B.11.23)

Itanium HP-UX SDK
1.4.2.05

No

SuSE Linux
Enterprise
Server 9 SP2

Intel (x86) WebLogic
JRockit 1.4.2_05
SDK

No

BEA WebLogic
Server 8.1
SP5 & BEA
WebLogic
Express 8.1 SP5

Windows 2000
SP4 Update
Rollup 1

Intel Pentium Sun SDK
1.4.2_08

WebLogic
JRockit 1.4.2_08
SDK

No

Windows
Server 2003 SP1
(32-bit version)

Intel Pentium Sun SDK
1.4.2_08

WebLogic
JRockit 1.4.2_08
SDK

No
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Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

Solaris 8 SPARC Sun SDK
1.4.2_08

BEA JRockit
1.4.2_08 SDK

No

Solaris 9 SPARC Sun SDK
1.4.2_08

BEA JRockit
1.4.2_08 SDK

No

Solaris 10 SPARC Sun SDK
1.4.2_08

BEA JRockit
1.4.2_08 SDK

No

HP-UX 11 PA-RISC HP-UX SDK
1.4.2.08

No

HP-UX 11i
version 2
Update 2
(B.11.23)

PA-RISC HP-UX SDK
1.4.2.08

No

Red Hat
Enterprise
Linux 3.0
Update 6

Intel (x86) WebLogic
JRockit 1.4.2_08
SDK

No

Red Hat
Enterprise
Linux 4.0
Update 2

Intel (x86) WebLogic
JRockit 1.4.2_08
SDK

No

Tomcat 5.0.28 Windows 2000
SP4 Update
Rollup 1

Intel Pentium Sun JDK
1.4.2_05

No

Windows
Server 2003 SP1
(32-bit version)

Intel Pentium Sun JDK
1.4.2_05

No

Solaris 8 SPARC Sun JDK
1.4.2_05

No
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Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

Solaris 9 SPARC Sun JDK
1.4.2_05

No

Solaris 10 SPARC Sun JDK
1.4.2_05

No

HP-UX 11 PA-RISC HP JDK
1.4.2_05

No

HP-UX 11i
version 2
Update 2
(B.11.23)

Itanium

PA-RISC

HP JDK
1.4.2_05

No

Red Hat
Enterprise
Linux 3.0
Update 6

Intel (x86) Sun JDK
1.4.2_05

No

Red Hat
Enterprise
Linux 4.0
Update 2

Intel (x86) Sun JDK
1.4.2_05

No

SuSE Linux
Enterprise
Server 9 SP2

Intel (x86) Sun JDK
1.4.2_05

No

IBM
WebSphere
Application
Server V5.1.1
Cumulative Fix
7 (5.1.1.7)

Windows 2000
SP4 Update
Rollup 1

Intel Pentium IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature

Windows
Server 2003 SP1
(32-bit version)

Intel Pentium IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature
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Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

SuSE Linux
Enterprise
Server 9 SP2

Intel (x86) IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

No

Solaris 8 SPARC IBM 32-bit SDK
for Solaris, Java
2 Technology
Edition,
Version 1.4.2

No

Solaris 9 SPARC IBM 32-bit SDK
for Solaris, Java
2 Technology
Edition,
Version 1.4.2

No

Red Hat
Enterprise
Linux 3.0
Update 6

Intel (x86) IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

No

Red Hat
Enterprise
Linux 4.0
Update 2

Intel (x86) IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

No

AIX 5L V5.2
ML6

Power IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature

AIX 5L V5.3
ML2

Power IBM 32-bit
SDK, Java 2
Technology
Edition, v1.4.2

Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature
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Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

Oracle 10g
Patch Set 2
(9.0.4.2)

Windows 2000
SP4 Update
Rollup 1

Intel Pentium JDK 1.4.2_05 No

Windows
Server 2003 SP1
(32-bit version)

Intel Pentium JDK 1.4.2_05 No

SuSE Linux
Enterprise
Server 9 SP2

Intel (x86) JDK 1.4.2_05 No

Solaris 8 SPARC JDK 1.4.2_05 No

Solaris 9 SPARC JDK 1.4.2_05 No

Solaris 10 SPARC JDK 1.4.2_05 No

HP-UX 11 PA-RISC JDK 1.4.2_05 No

HP–UX 11i
version 2
Update 2
(B.11.23)

PA-RISC JDK 1.4.2_05 No

Red Hat
Enterprise
Linux 3.0
Update 6

Intel (x86) JDK 1.4.2_05 No

Red Hat
Enterprise
Linux 4.0
Update 2

Intel (x86) JDK 1.4.2_05 No

AIX 5L V5.2
ML6

Power IBM SDK
1.4.2_05

No

AIX 5L V5.3
ML2

Power IBM SDK
1.4.2_05

No

Oracle 10g
Release 2
(10.1.2)

Windows 2000
SP4 Update
Rollup 1

Intel Pentium JDK 1.4.2_05 No

Windows
Server 2003 SP1
(32-bit version)

Intel Pentium JDK 1.4.2_05 No

Web Development Kit Applications Language Pack Installation and Release Notes 31



Environment and System Requirements

Application
Server

Operating
System

Processor JDK Clustering
Support
(Failover)?

SuSE Linux
Enterprise
Server 9 SP2

Intel (x86) JDK 1.4.2_05 No

Solaris 8 SPARC JDK 1.4.2_05 No

Solaris 9 SPARC JDK 1.4.2_05 No

Solaris 10 SPARC JDK 1.4.2_05 No

HP-UX 11 PA-RISC JDK 1.4.2_05 No

HP–UX 11i
version 2
Update 2
(B.11.23)

PA-RISC JDK 1.4.2_05 No

Red Hat
Enterprise
Linux 3.0
Update 6

Intel (x86) JDK 1.4.2_05 Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature

Red Hat
Enterprise
Linux 4.0
Update 2

Intel (x86) JDK 1.4.2_05 Yes for all
except DAM,
DCM, DCO,
and the Web
Publisher
Portlet Builder
feature

Sun Java
System
Application
Server 7
2004Q2 Update
3

Solaris 8 SPARC JDK 1.4.2_07 No

Solaris 9 SPARC JDK 1.4.2_07 No

Solaris 10 SPARC JDK 1.4.2_07 No
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Exceptions

For application servers supported with these localized applications, the following
exceptions apply:
• We support the English version of Tomcat on English, Japanese, and Korean

operating systems.
• If you licensed the Web Publisher Portlet Builder feature, then only the following

application server environments are supported:

— BEA WebLogic on Windows operating systems

— BEA WebLogic on Solaris operating systems

— Tomcat on Windows operating systems
• Clustering (failover) is not supported for BEA WebLogic Server 8.1 SP5. The English

Release Notes for version 5.3 SP1 of your English product provide information about
which configurations of BEA WebLogic Server 8.1 SP4 and BEA WebLogic Express
8.1 SP4 support clustering (failover).

Notes

Unless otherwise noted:
• HTTP servers internal to the supported application servers are supported.
• The HTTP server associated with an application server, whether internal or external,

must also support chunked requests. This means that HTTP servers forward HTTP
requests using chunked transfer encoding (as described in the HTTP/1.1 protocol) to
the back-end application server.

If chunked requests are not supported then the client should use "UCF Alternative
Chunking" mode. For details on configuring and using "UCF Alternative Chunking"
mode, refer to the Web Development Kit and Applications Development Guide for
version 5.3 SP2 or the Documentum 5.3.x System Deployment Guide for version
5.3 SP2.

Refer to External HTTP Server Environments, page 34 for more information about
supported HTTP server configurations.

• The operating systems listed in this table include virtualized versions of the
operating system running in any version of VMware Intel-architecture (VMware ESX
Server, GSX Server and Workstation).

• XWindows is required for the GUI-based installer on UNIX operating systems.
• IBM WebSphere Business Integration Server Foundation was formerly known as

WebSphere Application Server Enterprise.
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The following IBMWebSphere Application Server 5.1.x editions are supported with
this release of Documentum: WebSphere AS, WebSphere AS Network Deployment,
and WebSphere Business Integration Server Foundation.

• Sun Java System Application Server was formerly known as Sun ONE Application
Server.

• We support 100% Intel compatible processors. Customers will have to obtain the
100% compatibility statement and guarantee/assurance from the processor and OS
vendors and log bugs directly with those vendors if any compatibility issues are
discovered.

• We support 64-bit version of Red Hat Linux and SuSE Linux through the 32-bit
compatibility mode with 100% Intel compatible processors, such as AMD64 or Intel
EM64T.

• PDF Annotation Services (PAS) 5.3 SP2 works only with Webtop 5.3 SP2, which
includes DFC 5.3 SP2. In addition, PAS does not includes DFC in its installer or
.war file. You must install DFC separately and deploy PAS on top of it. PAS 5.3 SP2
requires DFC 5.3 SP2, (the same version as DFC that comes with Webtop 5.3 SP2).

• If you are running Oracle 10.1.2 on HP-UX, you must install Oracle patch 4220329.

External HTTP Server Environments

This section describes supported HTTP server configurations for application servers
used with localized WDK-based applications.

The HTTP servers listed in Table 4–4, page 34 are supported for the operating systems
specified in Table 4–3, page 27.

Table 4-4. External HTTP Server Environments

HTTP Server Clustering Support?

Apache 2.0.55 No

Microsoft Internet Information Server
(IIS) 5.0

No

Microsoft Internet Information Server
(IIS) 6.0

No

Sun Java System Web Server 6.1 SP4 Failover, Load Balancing

34 Web Development Kit Applications Language Pack Installation and Release Notes



Environment and System Requirements

Exceptions

None in this release

Notes

The listed HTTP servers are supported for the operating systems specified in Table
4–3, page 27.

Application Connectors environment

This release of Digital Asset Manager, Webtop and Documentum Client for Outlook
includes Application Connectors, which are installed on the browser client to make
repositories available within a Windows application such as Microsoft Word, Excel or
Outlook.

Table 4-5. EMC Documentum Application Connectors

Client Operating
System

Client Application Browser Application Server

Windows 2000 SP4
Update Rollup
1 with .NET
Framework 1.1 SP1

Microsoft Office XP
SP3*

Microsoft Office
2003 SP2*

Microsoft Internet
Explorer 6.0 SP1

(SeeTable 4–2,
page 23 for a
list of supported
operating systems
and Java Plug-ins.)

See Table 4–3,
page 27 for a
list of supported
application server
environments.

Windows XP SP2
(32-bit version)with
.NET Framework
1.1 SP1

Microsoft Office XP
SP3*

Microsoft Office
2003 SP2*

Microsoft Internet
Explorer 6.0 SP1

(SeeTable 4–2,
page 23 for a
list of supported
operating systems
and Java Plug-ins.)

See Table 4–3,
page 27 for a
list of supported
application server
environments.

Web Development Kit Applications Language Pack Installation and Release Notes 35



Environment and System Requirements

Client Operating
System

Client Application Browser Application Server

Windows Server
2003 SP1 (32-bit
version) with .NET
Framework 1.1 SP1

Microsoft Office XP
SP3*

Microsoft Office
2003 SP2*

Microsoft Internet
Explorer 6.0 SP1

(SeeTable 4–2,
page 23 for a
list of supported
operating systems
and Java Plug-ins.)

See Table 4–3,
page 27 for a
list of supported
application server
environments.

* Only Word, Excel, and PowerPoint from the Office Suite are supported.

Exceptions

None in this release

Notes

None in this release

Content Server environment

If you licensed the Web Publisher Portlet Builder feature, the following Content Server
Environments are supported.

Table 4-6. Content Server environment

Operating System Supported Processor
Type

RDBMS

Solaris 8 UltraSPARC Oracle 9i Release 2 (9.2.0.7)

Oracle 10g Release 1 (10.1.0.4)

Oracle 10g Release 2 (10.2.0.1)

Solaris 9 UltraSPARC Oracle 10g Release 1 (10.1.0.4)

Oracle 10g Release 2 (10.2.0.1)

36 Web Development Kit Applications Language Pack Installation and Release Notes



Environment and System Requirements

Operating System Supported Processor
Type

RDBMS

Windows 2000 SP4 Update
Rollup 1

Intel Pentium Oracle 9i Release 2 (9.2.0.7)

Oracle 10g Release 1 (10.1.0.4)

Oracle 10g Release 2 (10.2.0.1)

Windows Server 2003 SP1
(32-bit version)

Intel Pentium Oracle 9i Release 2 (9.2.0.7)

Oracle 10g Release 1 (10.1.0.4)

Oracle 10g Release 2 (10.2.0.1)

Exceptions

None in this release

Notes

Unless otherwise noted:
• The RDBMS may be installed on a different machine from Content Server. See the

Content Server Installation Guide for detailed descriptions of the Content Server and
RDBMS installation environment.

• XWindows is required for the GUI installer on UNIX operating systems.
• The following Windows 2000 editions are supported: Server, Advanced Server,

Data Center Server
• The following Windows 2003 editions are supported: Standard, Enterprise, Data

Center
• The operating systems listed in this table include virtualized versions of the

operating system running in any version of VMware Intel-architecture (VMware ESX
Server, GSX Server and Workstation).

• English, Japanese, and Korean operating systems are supported.
• We support 100% Intel compatible processors. Customers will have to obtain the

100% compatibility statement and guarantee/assurance from the processor and OS
vendors and log bugs directly with those vendors if any compatibility issues are
discovered.

• For Content Server running with Oracle 10g (10.1.0.x) databases, the minimum
required version is 10.1.0.3.
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• The following Japanese and Korean localized RDBMS are supported:

— Oracle

Portal Server environment

Web Development Kit for Portlets, and the Web Publisher Portlet Builder runs in a portal
server environment. The portal server environment consists of a specific combination of
operating system, application server, portal server, and JDK. The following table lists the
supported application server environments for portlets.

Table 4-7. Portal Server environment

Portal Server Portal’s Operating
System

Processor JDK

BEA WebLogic
Portal 8.1 SP4

SuSE Linux
Enterprise Server 9
SP2

Intel (x86) WebLogic JRockit
1.4.2_05 SDK

BEA WebLogic
Portal 8.1 SP5

Windows 2000 SP4
Update Rollup 1

Intel Pentium Sun SDK 1.4.2_08

WebLogic JRockit
1.4.2_05 SDK

Windows Server
2003 SP1 (32-bit
version)

Intel Pentium Sun SDK 1.4.2_08

WebLogic JRockit
1.4.2_08 SDK

Solaris 8 SPARC Sun SDK 1.4.2_08

WebLogic JRockit
1.4.2_08 SDK

Solaris 9 SPARC Sun SDK 1.4.2_08

WebLogic JRockit
1.4.2_08 SDK

Solaris 10 SPARC Sun SDK 1.4.2_08

WebLogic JRockit
1.4.2_08 SDK

HP-UX 11 PA-RISC HP-UX SDK
1.4.2.08
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Portal Server Portal’s Operating
System

Processor JDK

HP-UX 11i Version
2 Update 2 (B.11.23)

PA-RISC HP-UX SDK
1.4.2.08

Red Hat Enterprise
Linux 3.0 Update 6

Intel (x86) BEA JRockit
1.4.2_08 SDK

Red Hat Enterprise
Linux 4.0 Update 2

Intel (x86) BEA JRockit
1.4.2_08 SDK

IBM WebSphere
Portal 5.1.0.1

Windows 2000 SP4
Update Rollup 1

Intel Pentium IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

Windows Server
2003 SP1 (32-bit
version)

Intel Pentium IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

Solaris 8 SPARC IBM 32-bit SDK
for Solaris, Java 2
Technology Edition,
Version 1.4.2

Solaris 9 SPARC IBM 32-bit SDK
for Solaris, Java 2
Technology Edition,
Version 1.4.2

Solaris 10 SPARC IBM 32-bit SDK
for Solaris, Java 2
Technology Edition,
Version 1.4.2

AIX 5L V5.2 ML6 Power IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

AIX 5L V5.3 ML2 Power IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

Red Hat Enterprise
Linux 3.0 Update 6

Intel (x86) IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2
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Portal Server Portal’s Operating
System

Processor JDK

Red Hat Enterprise
Linux 4.0 Update 2

Intel (x86) IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

SuSE Linux
Enterprise Server 9
SP2

Intel (x86) IBM 32-bit SDK,
Java 2 Technology
Edition, v1.4.2

Exceptions

Unless otherwise noted:
• For the BEA Weblogic Portal 8.1 SP5 Portal Server, the PointBase database is not

supported.

Notes

Unless otherwise noted, Documentum recommends using the vendor-supplied JDK
• The following Portal Application Servers are supported:

— For the BEA WebLogic Portal 8.1 SP4 Portal Server: WLS 8.1 SP4

— For the BEA WebLogic Portal 8.1 SP5 Portal Server: WLS 8.1 SP5

— For the IBMWebSphere Portal 5.1.0.2 Portal Server: IBMWebSphere Application
Server V5.1.1 Cumulative Fix 4 (5.1.1.4)

• If you are running with the IBMWebSphere Portal 5.1.0.2 Application Server V5.1.1
Cumulative Fix 4 (5.1.1.4) , the following Efixes are required:

— PK00049

— PK00346

— PK0132_5.1.1_iFix

— PK0173

— PK05760

— PQ91124

— PQ92527

— PQ94554
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— PQ97031

— PQ9708

— PQ99499

— PQ99864

— PQ99966
• The following Portal Directory Servers are supported:

— For the BEA WebLogic Portal 8.1 SP4 & SP5 Portal Server: use the embedded
Portal Directory Server

— For the IBM WebSphere Portal 5.1.0.2 Portal Server: Any supported by
WebSphere Portal (IBM Directory Server 5.1 with DB2 8.1 is recommended)

• The following databases are supported with the following Portal Servers:

— For the BEA WebLogic Portal 8.1 SP4 or SP5 Portal Server: any enterprise
database supported by the WebLogic Portal Server

— For the IBMWebSphere Portal 5.1.0.2 Portal Server: any database supported by
the WebSphere Portal Server

Express is not supported because the Documentum installer installs elements to
the Cloudscape 5.1.26 database.

— Developers may use theWeb Development Kit Development Guide andWDK for
Portlets Environment Layer Customization Guide to port Documentum Portlets to
any portal server even if it does not support the JSR 168 specification.

Documentum Client for Outlook Supported Client
Environments

The following table lists supported operating systems and versions of Microsoft Outlook
supported with this release of DCO.

Table 4-8. DCO Supported Clients

Client Operating System Outlook Client Client Java Plug-in

Windows 2000 SP4 Update
Rollup 1 (32-bit version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

MS JVM 5.0.0.3810
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Client Operating System Outlook Client Client Java Plug-in

Windows 2000 SP4 Update
Rollup 1 (32-bit version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

Sun JRE 1.4.2_09

Windows XP SP2 (32-bit
version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

MS JVM 5.0.0.3810

Windows XP SP2 (32-bit
version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

Sun JRE 1.4.2_09

Windows Server 2003 SP1
(32-bit version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

MS JVM 5.0.0.3810

Windows Server 2003 SP1
(32-bit version)

Microsoft Outlook 2002
(Outlook XP)

Microsoft Outlook 2003

Sun JRE 1.4.2_09

Notes

• WDK version 5.3 SP2 is bundled with DCO.
• Required on all clients: Sun JRE 1.4.2_09. If Microsoft JVM is present, then in addition

to the above Sun JRE, the Microsoft JVM version must be Microsoft JVM 5.0.0.3810.

Exceptions

Unless otherwise noted:
• Outlook Web Access Client not supported
• No Citrix support
• Localized Japanese and Korean DCO applications are not supported when DCO is

configured to use the dm_mail_message type.
• Microsoft Outlook 2002 is not supported for Japanese and Korean. Use Microsoft

Outlook 2003 SP2 if you need Japanese or Korean language support.
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Additional operating environments

The following table provides information on additional supported operating
environments for WDK-based applications.

Table 4-9. Additional Operating Environments

Product Operating Environment

Citrix MetaFrame Presentation Server 3.0

Citrix Presentation Server 4.0

Windows 2000 SP4 Update Rollup 1

Windows 2003 SP1 (32–bit version)1

VMware Workstation, GSX Server, ESX Server

eTrust Siteminder Policy Server 5.5 SP3

eTrust Siteminder Policy Server 6.0 SP2

Supportedwith Content Server-supported
environments.

Supported with the application servers
and operating systems supported by
WDK-based products.

Supported with the application servers
and operating systems supported by
Portlets products.

Exceptions

For the additional operating environments supported with this release, the following
exceptions apply:
• Digital Asset Manager, and WDK for Portlets are not certified for Citrix client.
• No support for eTrust Siteminder Policy Server on Linux
• Netscape and Firefox Web browsers are not supported with eTrust Siteminder.

Notes

Unless otherwise noted:
• Documentum fully supports all of our products running on an OS being virtualized

within any version of VMware Intel-architecture as long as that OS is supported by
the appropriate Documentum product.
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• Computer Associates eTrust SiteMinder was formerly known as Netegrity
SiteMinder.

Third-Party products for Web Publisher

The following table lists optional and included third-party products for Web Publisher.
Ephox is included with Web Publisher; eWebEditPro and iMarkup are optional
third-party products.

Table 4-10. WCM 5.3. SP1 Third Party Products

Product Type Operat-
ing Sys-
tem

Appli-
cation
Server

Data-
base

Browser Java
Plug-in

Status

eWebE-
dit-
Pro+XML
V4.2

Client Win-
dows
NT

Win-
dows
2000

Win-
dows XP
(32-bit
version)

N/A N/A Internet
Explorer
5.5 or
higher

N/A Op-
tional

Ephox
4.0

Client Sup-
ported
on all
Web
Pub-
lisher
browser
clients

N/A N/A Sup-
ported
on all
Web
Pub-
lisher
browser
clients

Same
as Web
Browser
clients

Installed
with
Web
Pub-
lisher

iMarkup
Java An-
notation
SDK
1.11

Client &
Server

AIX 5L
V5.2
ML6

AIX 5L
V5.3
ML2

Red Hat
Enter-
prise

Tom-
cat, BEA
We-
bLogic,
IBM
Web-
Sphere
(Same
versions
as sup-

SQL
Server,
Oracle
(Same
versions
as sup-
ported
by Con-
tent
Server)

iMarkup
Plugin:
Sup-
ported
on all
Web
Pub-
lisher
browser
clients

Same
as Web
Browser
clients

Op-
tional
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Product Type Operat-
ing Sys-
tem

Appli-
cation
Server

Data-
base

Browser Java
Plug-in

Status

Linux
3.0 Up-
date 6

Red Hat
Enter-
prise
Linux
4.0 Up-
date 2

Solaris 8

Solaris 9

Solaris
10

SuSE
Linux
Enter-
prise
Server 9
SP2

Win-
dows
2000 SP4
Update
Rollup 1

Win-
dows
Server
2003 SP1
(32-bit
version)

ported
by Web
Pub-
lisher)

Exceptions

Unless otherwise noted:
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• eWebEditPro supports Internet Explorer browsers only.

Notes

None for this release

Third-Party Products for DCM

The following table lists third-party products that enable full functionality for
Documentum Compliance Manager.

Table 4-11. DCM 5.3. SP1 Third Party Products

Product Version Optional or Required?

Liquent PDFaqua 5.2 SP1 Optional

PDFsign 5.2 SP1 Optional

Cross product dependencies
The following table lists optional and required versions of products that are depended
on in order to enable additional features.

You may have to install some of the products listed in Table 4–12, page 46 on separate
host or client machines due to differences in the DFC versions included with those
products. Before installing a product, check the product’s installation guide for
supported installation configurations.

Table 4-12. Cross product dependencies

EMC Products* Included by Installer

For Digital Asset Manager:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2*

• File Share Services 5.3
• EMC Legato DiskXtender for
Unix/Linux 2.71

• DFC 5.3 SP2**
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EMC Products* Included by Installer

• Media Services 5.2.5, 5.2.5 SP1, 5.2.5
SP2, 5.2.5 SP3

• Media Transformation Services (MTS)
5.3, 5.3 SP1, 5.3 SP2

• Audio/Video Transformation Services
(AVTS) 5.3, 5.3 SP1, 5.3 SP2

• Document Transformation Services
(DTS) 5.3, 5.3 SP1, 5.3 SP2

• Advanced Document Transformation
Services (ADTS) 5.3, 5.3 SP1, 5.3 SP2

• Regulatory Publishing Transformation
Services (RPTS) 5.3 SP2

For DocumentumApplication Connectors:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2*

• One of the following:
— DAM 5.3 SP2
— WDK 5.3 SP2
— Webtop 5.3 SP2
— DCO 5.3 SP2

N/A

For Webtop:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2*

• Documentum Administrator 5.2.5 SPx,
5.3, 5.3 SP1, 5.3 SP2

• Documentum Application Connectors
5.3 SP2

• ECIS 5.3, 5.3 SP1, 5.3 SP2
• PDF Annotation Services, 5.3 SP2

• DFC 5.3 SP2**

For PDF Annotation Services:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2*

• DFC 5.3 SP2**
• Webtop 5.3 SP2

N/A
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EMC Products* Included by Installer

For Web Publisher
• Content Server 5.3, 5.3 SP1, 5.3 SP2*
• WDK 5.3, 5.3 SP1, 5.3 SP2
• Business Process Services 5.3, 5.3 SP1,
5.3 SP2

• Content Intelligence Services 5.2.5 SPx,
5.3, 5.3 SP1, 5.3 SP2

• Content Transformation Services 5.3
SP1, 5.3 SP2

• Document Transformation Services 5.3
SP1, 5.3 SP2

• Documentum Administrator 5.3, 5.3
SP1, 5.3 SP2

• Documentum Application Builder 5.2.5
SPx, 5.3, 5.3 SP1, 5.3 SP2

• FTP Services 5.3, 5.3 SP1, 5.3 SP2 (when
released)

• Media Services 5.2.5, 5.2.5 SPx
• Media Transformation Services (MTS)
5.3, 5.3 SP1, 5.3 SP2

• Site Caching Services 5.2.5, 5.2.5 SPx,
5.3, 5.3 SP1

• Thumbnail Server 5.2.5, 5.2.5 SPx,

• DFC 5.3 SP2**
• Application Installer

For WDK for Portlets:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2

• DFC 5.3 SP2**

N/A

For Documentum Client for Outlook:
• Content Server 5.2.5, 5.2.5 SPx, 5.3, 5.3
SP1, 5.3 SP2*

• Documentum Administrator 5.3, 5.3
SP1, 5.3 SP2

• DFC 5.3 SP2**
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EMC Products* Included by Installer

For Documentum Compliance Manager:
• Content Server 5.3, 5.3 SP1, 5.3 SP2*
• DFC 5.3, 5.3 SP1, 5.3 SP2**
• Document Transformation Services
(DTS) 5.3, 5.3 SP1, 5.3 SP2

• PDF Annotation Services 5.3

• DFC 5.3 SP2**

* Interoperability with all other 5.3.x version Documentum client products, while not
required to enable full functionality, is supported. Documentum 5.3 products do not
support any 4.x version of Content Server. DCO 5.3 and 5.3 SPx running with 5.2.5
versions of Content Server require an additional post-installation step, described in the
Installation chapter of the Documentum Client for Outlook Release Notes.

When Documentum Client for Outlook (DCO) is configured to use the
dm_message_archive type, Content Server 5.3 SP2 is required.

Web Publisher 5.3 and 5.3 Service Pack releases do not support any 4.x or 5.2.5 versions
of Content Server because the server files installed with Web Publisher require DFC
5.3 or 5.3 SPx.

** This version of DFC works properly with any Documentum client product with
version number 5.2.5 or 5.3, with the exception of the following DFC features, which
work only when DFC is accessing Content Server version 5.3 or 5.3 SPx:
• Fetching service-based object (SBO) implementations from a repository’s global
registry (Pre-5.3 Documentum systems do not have global registries.)

• Web Services 5.3 or 5.3 SPx

By default, Content Server with Collaboration Services or RPS enabled can accept
only version 5.3 or 5.3 SPx clients. See the product documentation for instructions
on how to change this setting.

For information about the supported configurations for products listed in this table,
see the Release Notes for the product.
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Chapter 5
Known Problems and Limitations

This section identifies problems and limitations that may affect your use of the product.

Note: This section and the Technical Notes section may refer to platforms or features that are not
supported for this release of your product. Check Chapter 4, Environment and System Requirements
to verify requirements.

EMC Documentum makes the latest information about customer-reported issues and known
problems available at CustomerNet support site (http://softwaresupport.emc.com/support). You must
have a software support agreement to log in and access the list of issues.

Known problems
This section describes known defects in EMC Documentum software that may affect
your use of the product.

WDK Applications common bugs

Known bugs affect all languages unless otherwise noted.

The section list bugs that affect all localized WDK applications.

Double-byte characters are corrupted when executing a DQL or API
command (90865)

If you are using a Japanese or Korean localized application and your administrator
accesses the DQL Editor or API Tester pages to monitor your application, any
double-byte characters are corrupted upon executing a DQL query or API command.
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Using extended characters in lifecycle state names (63015)

WDK-based applications do not support using extended characters in lifecycle state
names. Extended characters include such characters as Japanese or Korean double-byte
characters, or accents (ê, ö). You must only use ASCII characters in your lifecycle state
names.

Error message of check-in label is incorrect for accented/double-
byte characters (97608)

In all WDK-based applications, when you enter a label in the check in page using
accented characters greater than 16 or double-byte characters greater than 10, the English
error message for the check-in label shows < 32 which is only correct for English. For
accented characters it should be < 16, and for double-byte characters it should be < 10.

Ofce application hangs after you open the PDF in Help and then
invoke any menu (97740)

In the AppConnector, Office Application hangs whenever you invoke any Documentum
menus after opening and closing the PDF in the help.

Workaround: Modify line 21 of /help/en/Documentum Application Connectors/nav.htm
from
<FONT face="Arial"size="1"><b><a href='./userguide.pdf'target='_top’>
Accessible Help Documentation.pdf </a></b><br><br></FONT></td>

to
<FONT face="Arial" size="1"><b><a href='./userguide.pdf'target='_blank’>
Accessible Help Documentation.pdf </a></b><br><br></FONT></td>

Month and year display (62199)

The Documentum calendar displays the month and then the year, mm/yyyy for the
localized Korean and Japanese product. The date should be displayed as year and then
month, yyyy/mm.
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English strings and U.S. date format displayed on import le
selector page with Mac browser (74212)

On Macintosh OS X with the French, Italian, German, Spanish, and Swedish locales,
English strings and U.S. date format are displayed in the import file selector page when
you select files to import.

Displaying English text in localized applications (73139)

If your browser language and your WDK-based application language are not the same
then you may see inconsistencies in language display. For example, if your browser
is using Japanese, and you open your WDK-based application in English the Browse
button on the check in page will be in Japanese not English.

Corrupted le names using Mac OS (72127)

Importing a file with extended characters into a repository using Mac OS 10.2 with a
localized or English version of Netscape 7.0.2, and 7.1, may cause character corruption in
the file name.

Workaround: Retype the name of the file in the Object Definition page.

The strings and icons are inconsistent with the native OS for the
same page (90372)

In Windows 2003, the icons that are displayed when invoking importing/browsing a local
file have misleading images. They are inconsistent with the native OS for the same page.

The PDF link in help is missing for J - Mac Safari (96155)

When you launch online Help fromWebtop, the PDF link is missing for J - Mac Safari.

Workaround: Access the PDF using the following link in your Safari browser replacing
the host name and the locale.

Example 5-1. For Example:
For Japanese, the locale would be ja_JP)
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http://<hostName>:<portNo>/webtop/help/<Locale>/userguide.pdf

Alphabetical properties (64245)

Properties are not sorted alphabetically in the Properties page of a document.

Webtop specic bugs

This section lists Webtop specific bugs that affect all languages unless otherwise noted.

Double-byte characters in title and document names are corrupted
(96466)

In Macintosh and Windows OS, when you log on to Webtop and navigate to Categories
and then back to a regular cabinet, the double-byte characters in the title and document
names are corrupted.

Workaround: After leaving the Categories page navigate to, or click another area of the
application and return to a regular cabinet.

Digital Asset Manager specic bugs

This section lists DAM specific bugs that affect all languages unless otherwise noted.

Right hand frame of online help does not load and PDF link is
missing (80785)

On Macintosh OS X with Internet Explorer 5.2.3, and Macintosh OS 9x with Internet
Explorer 5.1.7, the right hand frame in Digital Asset Manager online Help fails to load a
Help page, and the PDF link is missing.
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Documentum Compliance Manager specic bugs

This section lists DCM specific bugs that affect all languages unless otherwise noted.

Specifying a date range in Japanese and Korean reports returns an
error (107931)

The error appears when Japanese and Korean reports are generated for Audit Trail,
Signoff Status, Average Signoff Time, Controlled Documents, Documents Not Accessed,
Promotion Status, and TBR Status using the From/To date fields. This is seen when
using a SQL Server repository.

Workaround: Use “Any Dates”, instead of using the From/To date fields, to generate
reports by checking the Any Dates checkbox. After the report is created, sort the report
by date and look for the date range.

Japanese - In Classic View, there is no space between Tools and
Compliance menu (107612)

There is no space between "Tools" and "Compliance" on the menu bar.

KJ, date format of the saved snapshot is in European format
(107496)

Japanese and Korean date formats of the saved snapshot is wrong. It is saved as "dd mm
yyyy". The correct format for Korean and Japanese is "yyyy mm dd".

Users can export the xml le created but cannot view it using
Internet Explorer (107310)

Saved reports and snapshots in XML page will not be displayed properly if invalid
characters are in content. This bugs is applicable to the FIGSJKE languages.

Workaround: Open the XML file using an XML editor or Notepad.
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German , XX strings in the renditions page (103972)

In German renditions page, the title of the page is displayed as “MSG_TITLE” instead of
“Formatvarianten”.

Some localized error messages show up in English (102723)

Even though localized DcmNlsString.properties and DcmNlsException.properties files
are included in dcm.jar file of the appserver and content server dcm.jar, some error
messages show up in English.

All Inbox notications related to DCM are in English (102475)

The attributes of a controlled print copy are corrupted if they have Japanese or Korean
characters. Note that the attributes display correctly in the user interface but not in the
printout.

Japanese and Korean characters in the attributes of a controlled
print copy will be corrupted (74400)

All inbox notifications related to DCM are in English even though properties files are
manually included in the DCM content server dcm.jar file.

Double-byte and accented characters are corrupted on the
e-Signature page of a controlled document (73610)

You will see corrupted double-byte and accented characters on the e-Signature page of a
controlled document in the following items:
• file name
• document name
• user name
• justification text
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Documentum Client for Outlook specic bugs

This section lists DCO specific bugs that affect all languages unless otherwise noted.

Corrupted attachment name on imported email messages(114913)

When importing an email message whose attachment name contains accented or
double-byte characters, the accented or double-byte characters are replaced by a space.
This issue only appears in profiles configured to use the dm_message_archive message
type.

Note: The attachment names accented and double byte characters display corrupted in
the Import Options page; however, after import, the attachment name is not corrupted.

Corrupted characters in the lename of exported email (114778)

Dragging and dropping an email message of type dm_message_archive from a repository
to an external location corrupts the accented and double-byte characters in the filename
of the exported email message. There is currently no known workaround for this issue.

Note: Even though the filename is corrupted users can open the email. There is no
corruption of the data within the email ike(subject, content, attachment name).

Localized online help does not display (114982)

Accessing online help from a localized Documentum Client for Outlook (DCO) within
Outlook opens the English online Help system. English online helps opens even though
localized help is installed.

Note: Accessing online help from a localized DCO via the web correctly launches the
localized online Help.

Workaround: To access localized online Help from within Outlook you must manually
change the online URL to point to online Help system for your locale.

To manually change the URL:

1. Click the online Help button within DCO.
The online Help launches in a browser with the following URL:
http://server.port/dco/help/en/default.htm?startat=managing_properties.htm
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2. In the browser, select the en locale in the URL and replace it with the locale for
your language. For example, http://server.port/dco/help/de_DE/default.htm?startat=
managing_properties.htm
The German online Help should reload.

Limitations
This section describes limits on the usability of current functionality. The limitations
may be part of the product design or may result from issues with associated third-party
products.

Limitations common to all WDK Applications

Grammatical normalization not available for Swedish (110862)

If you are using the index server, grammatical normalization and other advanced
linguistic features are not available for Swedish.

Virtual link feature does not support Unicode or double-byte
characters

Unicode and double-byte characters are not supported for the Virtual Link feature
because the URL standard does not support Unicode or double-byte characters.

If you have installed a WDK-based application with virtual link support and you access
a document in a cabinet using a URL (virtual link) you must ensure that the URL does
not contain Unicode or double-byte characters.

CIS automatic categorization supports ASCII characters only

If your implementation uses the automatic categorization features of Content Intelligence
Services, the names of categories and taxonomies appearing under the Categories node
in Webtop or Web Publisher can include characters from the ASCII character set only.
The evidence strings that CI Server uses to assign documents to categories can also
include only ASCII characters.
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Differences between localized documentation and English
documentation

There may be differences between the localized documentation and the English
documentation of the WDK-based applications’ Help and related PDFs. Please refer to
the English version of the User Guide (PDF) that resides on the Download Center (
https://documentum.subscribenet.com.

Web Publisher specic limitations

This section lists Web Publisher specific limitations that affect all languages unless
otherwise noted.

Rendition description information is truncated (79527)

If you are using Web Publisher in the transformation rendition and import rendition
pages, the description fields allow 16 English characters, or 5 Japanese or Korean
characters, or 8 accented characters.

Web Publisher Portlet Builder feature not localized

The Web Publisher Portlet Builder 5.3 SP1 release does not include any localized UI or
documentation for the Portlet Builder feature. If you install the Portlet Builder feature
you will receive English UI and documentation.

Using CIS in Web Publisher

Content Intelligence Services (CIS) is not supported in languages other than English. To
avoid CIS errors in your localized install of Web Publisher ensure that CIS is turned
off by clearing the CIS Host and CIS Node fields located in Administration→Web
Publisher Admin→Settings on the External Resources tab.
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Double-byte characters in Web Publisher lenames (65252)

If your machine is not double-byte enabled and is using JVM 1.4.1 you cannot access
HTML or XML files for viewing using a double-byte hyperlink. You will receive an
error message.

Workaround: Change your browser plug-in to use Microsoft VM 1.1.8, or manually
navigate to the file location indicated in the error message.

Documentum Compliance Manager specic limitations

This section lists Documentum Compliance Manager (DCM) specific limitations that
affect all languages unless otherwise noted.

Creating business rule lists in different locales (76338)

If you create a business rule list in one locale and someone else creates a business rule
list in another locale, the second business rule list is not used only the first business
rule list is used.

Workaround: Use one locale.

Documentum Client for Outlook specic limitations

This section lists Documentum Compliance Manager (DCM) specific limitations that
affect all languages unless otherwise noted.

DCO Support for mail message object types

A newmail message object type has been introduced in DCO 5.3 SP2 to provide extended
and new functionality to email messages in DCO.

In 5.3 SP1, the dm_mail_message is the default object type assigned to newmail messages
added to the repository. 5.3 SP2 introduced a new mail message object type called
dm_message_archive to enable functionality not included in previous releases of DCO.

Some existing features using the dm_mail_message object type are available in SP2 with
the dm_message_archive object type configuration; however, not all locales containing
multibyte information (for example, subject, and attachment names) are supported with

60 Web Development Kit Applications Language Pack Installation and Release Notes



Known Problems and Limitations

the dm_message_archive object type. Following is a list of supported languages for
both object types.
• dm_mail_message object type

— French, Italian, German, Spanish, Swedish
• dm_message_archive object type

— French, Italian, German, Spanish, Swedish, Japanese and Korean
There is currently no migration path to convert features using the dm_mail_message
object type to the new dm_message_archive object type. Therefore, if you wish to
use dm_message_archive object type, your DCO environment must be a new 5.3 SP2
installation.

Refer to the English Documentum Client for Outlook Release Notes for a list of
features supported by both object types, and for configuration steps to enable the
dm_message_archive functionality in your 5.3 SP2 environment.
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Chapter 6
Technical Notes

This section provides configuration and usability notes for current product features.

Populating the data dictionary
Content Server stores information about object types and their attributes in the data
dictionary. During Content Server installation, the data dictionary files for English,
French, German, Italian, Spanish, Japanese, Korean, and Swedish are installed in
the Content Server. During repository creation, a set of data dictionary information
is loaded based on the Content Server host locale. Content Server currently supports
English, Japanese and Korean as a host locale. If the host locale is English, Japanese, or
Korean, the data dictionary information for that locale is loaded. Otherwise the host
locale is always English.

Note: Swedish is currently only supported with:
• Webtop 5.3 SP1, 5.3 SP2
• Web Publisher 5.3 SP1, 5.3 SP2
• Application Connectors 5.3 SP2
• Documentum Client for Outlook 5.3 SP2

When you install Content Server, by default the procedure automatically populates the
data dictionary with default information for one locale and sets the name of the locale
in the dd_locales attribute of the docbase config object.

To add a new locale use the population script provided by Documentum.

You can populate and publish the data dictionary file following the procedures located
in Appendix E, “Populating and Publishing the Data Dictionary,” in the Content Server
Administrator’s Guide version 5.3 SP1.
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Editing locales in the data dictionary
When a repository is configured, the data dictionary is populated with default
information for one locale. The locale is recorded in the dd_locales attribute of the
docbase config object for the repository when the dd_populate.ebs script runs during
repository configuration. The dd_locales attribute records the data dictionary locales that
are enabled in the repository. You can modify the dd_populate.ebs script after repository
configuration to update the languages that are enabled.

Client applications retrieve labels, value assistance, and constraints applying to types
and attributes from the data dictionary. It is recommended that you add only required
language information to the data dictionary because of the additional overhead added
to type modifications (such as CREATE, ALTER, and DROP) and to data dictionary
information retrieval.

To edit data dictionary locales:

1. Navigate to Documentum Administrator.

2. Connect as a Superuser to the repository whose docbase config object you want to
modify.

3. In the left-hand pane, click Configuration.

4. Click Repository.

5. Click .

6. On the Info tab click Edit beside the Data Dictionary Locales attribute.

7. Type a new value in the field labeled Enter new value and click Add, or select a
value from the Data Dictionary Locales list and click Remove

8. Click OK.

9. Click OK.

Technical notes specic to Web Publisher
This section provides configuration and usability notes specific to Web Publisher.
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Double-byte and accented descriptions for renditions
(79592, 79648)

If you are using Web Publisher, renditions created in Web cabinets must contain
descriptions in English.

When you import a rendition into a Web cabinet (from the File>New>Create
Rendition>Import Renditionmenu) be sure the description in the Description field on
the Import Rendition page does not contain double-byte or accented characters. If your
description does contain double-byte or accented characters the rendition is imported
with corrupted characters. The description becomes a part of the URL published to a
web site so double-byte or accented characters do not work.

Updating the Web Publisher data dictionary for the
Swedish locale

Web Publisher stores information about Web Publisher specific object types and their
attributes in the Web Publisher data dictionary. During Web Publisher DocApp
installation, the Web Publisher data dictionary information is loaded for the locales in
the current repository. To add the Swedish locale to the Web Publisher data dictionary
you must download the Swedish Web Publisher data dictionary file, modify the
data_dictionary_wcm.ini and dd_populate_wcm file in Content Server, and then run the
data dictionary population script.

To download the Swedish data dictionary le for Web Publisher:

1. Navigate to the Documentum download site (https://documentum.subscribenet.com)
and download the data_dictionary_wcm_sv_SE.txt file.

2. Save the data dictionary file to the Content Server directory.
• Windows: %DM_HOME%\bin\webPublisher\Utils\DataDictionary
• UNIX: $DM_HOME/bin/webPublisher/Utils/DataDictionary
You can now populate and publish the data dictionary file following the procedures
located in Appendix E, “Populating and Publishing the Data Dictionary,” in the
Content Server Administrator’s Guide.

To update the locales supported in the repository:

1. Use the instructions in Appendix E, “Populating and Publishing the Data
Dictionary,” in the Content Server Administrator’s Guide, to install the Swedish locale
in the repository.

2. Log in to the Content Server host as the Content Server installation owner.
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3. Navigate to the data_dictionary_wcm.ini file.
The default location is $DM_HOME/bin/webPublisher/Utils/DataDictionary (UNIX)
or %DM_HOME%\bin\webPublisher\Utils\DataDictionary (Windows).

4. Open the data_dictionary_wcm.ini file in a text editor.
The file lists the available locales.

5. Add the lines for the Swedish language at the end of the file.
data_dictionary_wcm_sv_SE.txt

6. Save and close the data_dictionary_wcm.ini file.

7. Open the dd_populate_wcm file in a text editor.
• On Windows, this is dd_populate_wcm.bat.
• On UNIX, this is dd_populate_wcm.sh.

8. Locate this line and substitute the appropriate repository name, user name, and
password:.
dmbasic -f%DM_HOME%\bin\dd_populate.ebs -eEntry_Point --
repository_nameuser_name password data_dictionary_wcm.ini
The repository name is the name of the repository you installed the Web Publisher
DocApp to, the user name is the name of the Superuser, and the password is the
Superuser’s password. You can use the Content Server installation owner’s user
name and password.

9. Save and close the dd_populate_wcm or dd_populate_wcm.sh file.

10. Run the script.
• On Windows, double-click dd_populate_wcm.bat.
• On UNIX, type dd_populate_wcm.sh.
The new data dictionary locale information is installed in the repository. When
the data dictionary publishing job runs next, the information is available to Web
Publisher.
To manually force a publish, use the following IAPI command. publish_dd,c,sv

Verifying the population of the Web Publisher data
dictionary

After you have updated the Web Publisher data dictionary with the Swedish locale you
can test your updates to ensure they were correctly populated to the repository.

To verify the population of the data dictionary:

1. Launch DAB (Documentum Application Builder).
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2. Log into the repository that you have populated with the Swedish Web Publisher
data dictionary.

3. In the repository, select File>Open and open the Web Publisher application.
The application will be in System/applications/WebPublisher folder

4. In DAB select View>locale>sv menu.
sv is enabled only after populating the Swedish data dictionary.

5. In the left hand frame of DAB, expand each object type and view the attribute label
values in the right hand frame. If the label values are in Swedish then you have
successfully populated the Web Publisher data dictionary with the Swedish locale.

Technical notes specic to Webtop
This section provides configuration and usability notes specific to Webtop.

Webtop forms page error messages display in English
(79908)

Error messages that display on the Forms page are not localized. All Forms page error
messages display in English.

Workaround: Set up localized error messages for forms in the Documentum Forms
Builder application. For details refer to the Documentum Forms Builder User Guide and
look for Adding a First Name Field (Text Input Control). In the Alert field on the Insert Text
Input page enter localized error messages.

Technical notes specic to Documentum
Compliance Manager

This section provides configuration and usability notes specific to Documentum
Compliance Manager.
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Updating the DCM data dictionary

A manual step, requiring you to run a script, is required to localize the repository for
DCM.

Labels for attributes are now internationalized.

Use these instructions to enable language support for additional locales. The sections
below contain instructions for:
• Adding supported locales to the repository
• Modifying the data_dictionary_dcm.ini file
• Running the data dictionary population script
1. Use the instructions, Populating and Publishing the Data Dictionary, in the Content

Server Administrator’s Guide, to install additional locales in the repository.

2. Log in to the Content Server host as the Content Server installation owner.

3. Edit the data_dictionary_dcm.ini file in the applicable default
location: $DM_HOME/bin/dcm/Utils/DataDictionary (UNIX) or
%DM_HOME%\bin\dcM\Utils\DataDictionary (Windows) using a text editor. The
file lists the available locales. They are commented out.

4. Uncomment the locales for which you need the DCM data dictionary information.

5. Save and close the data_dictionary_dcm.ini file.

6. Open the dd_populate_dcm file in a text editor.
On Windows, this is dd_populate_dcm.bat.
On UNIX, this is dd_populate_dcm.sh.

7. Locate this line and substitute the appropriate repository name, user name, and
password:
dmbasic --f%DM_HOME%\bin\dd_populate.ebs -eEntry_Point --
repository_nameuser_name password data_dictionary_dcm.ini
The repository name is the name of the repository you installed the DCM DocApp
to, the user name is the name of the Superuser, and the password is the Superuser’s
password. You can use the Content Server installation owner’s user name and
password

8. Save and close the dd_populate_dcm or dd_populate_dcm.sh file.

9. Run the script.
On Windows, double-click dd_populate_dcm.bat.
On UNIX, type dd_populate_dcm.sh.

The new data dictionary locale information is installed in the repository. When the data
dictionary publishing job runs next, the information is available to DCM.
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Technical notes specic to Documentum Client
for Outlook

This section provides configuration and usability notes specific to Documentum Client
for Outlook.

Documentum node missing in Microsoft Outlook
(113805)

The msaddndr.dll file is a Microsoft library built into the Microsoft Office application.
This DLL should be registered at all times; however, the Microsoft Office installation
process sometimes fails to register this DLL.

DCO requires Microsoft Outlook (and by extension, Microsoft Office), so its components
must be correctly registered. If the msaddndr.dll file (located in: in C:\Program
Files\Common Files\DESIGNER) is not properly registered when installing Microsoft
Office the Documentum Folders node will not display in Microsoft Outlook’s folder
list view.

Workaround: Uninstall DCO following the uninstall procedure in the Documentum Client
for Outlook Release Notes. Manually register the msaddndr.dll file following the procedure
below. Reinstall DCO following the installation procedure in theWeb Development Kit
and Applications Installation Guide.

To manually register the msaddndr.dll le:

1. In a command prompt, navigate to the location where the DLL is installed.

2. At the command prompt type:
regsvr32 msaddndr.dll

Updating the DCO data dictionary

Documentum Client for Outlook (DCO) stores information about DCO specific object
types and their attributes in the DCO data dictionary. During DCO DocApp installation,
the DCO data dictionary information is loaded only for English in the current repository.
To load additional locale specific data dictionary information to your repository you
must populate the DCO data dictionary files, data_dictionary_dco_profile_language code
and data_dictionary_dm_mail_message_language code file in Content Server.
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To download the data dictionary les for DCO:

1. Navigate to the Documentum download site (https://documentum.subscribenet.com)
and download the data dictionary zip file Client_for_Outlook_5.3_SP2_data_
dictionary.zip. The zip file contains all language data dictionary files, for example
data_dictionary_dco_profile_de.txt and data_dictionary_dm_mail_message_de.txt

2. Save the data dictionary files to the Content Server directory.
• Windows: %DM_HOME%\product\5.3\bin
• UNIX: $DM_HOME/product/5.3/bin
You can now populate and publish the data dictionary files following the procedures
located in Appendix E, “Populating and Publishing the Data Dictionary,” in the
Content Server Administrator’s Guide.

Verifying the population of the DCO data dictionary

After you have updated the DCO data dictionary with the a locale you can test your
updates to ensure they were correctly populated to the repository.

To verify the population of the data dictionary in DAB:

1. Launch DAB (Documentum Application Builder).

2. Log into the repository that you have populated with a locale data dictionary.

3. In the repository, select File>Open>language code and open the DCO application.
The application will be in System/applications/DCO folder

4. In DAB select View>locale.
The locale is enabled only after populating the data dictionary of the same locale.

5. In the left hand frame of DAB, expand each object type and view the attribute label
values in the right hand frame. If the label values are localized in your selected
language then you have successfully populated the DCO data dictionary with
a locale.

To verify the population of the data dictionary in DCO:

1. Launch DCO.

2. Log into the repository that you have populated with a locale data dictionary.

3. In DCO select a profile, and click the properties icon to view the properties of a
profile.
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The labels on the Properties page should display in the language of the selected
locale.
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Chapter 7
Documentation

This section describes the documentation related to this product.

Localization Documentation Set
The following document titles comprise the localization documentation set:
• Web Development Kit Applications Language Pack Installation and Release Notes 5.3 SP2

(this document)

Obtaining the correct documentation
The Downloads area of the CustomerNet support site (http://softwaresupport.emc.com/
support) contains the downloadable packages for specific product versions along with
the release notes, installation guide, and other relevant documentation associated with
the product version. Product documentation that is available online from the application
(Help, for example) does not appear as a separate item; it is automatically downloaded
and installed with the software.

You can also go to the Documentation area of the CustomerNet support site
(http://softwaresupport.emc.com/support) to download product documentation, order
printed documentation, or participate in the technical publications customer survey.

To locate product documentation, select the product and version number on the search
page, then click the Search button. To order printed versions or complete the customer
survey, click the appropriate link in the upper right of the page.

If the documentation you are looking for is not available in printed form from either of
the above sites, you can purchase it from Nexstra (email: support@nexstra.com, phone:
866-568-0650).
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Documentation corrections and clarications
This section lists corrections to the product documentation.

For information on core English application features for this release refer to the English
release notes.

Webtop documentation corrections

This section lists features that are updated or new for the localized documentation.
• Added the following sections:

— Configuring external searches

— Using quotes and operators to narrow a search

— Assigning a work queue task to a specific user
• Modified the following sections:

— Dragging and dropping

— Running a simple search

— Running an advanced search

— Working with Relationships

— Reordering descendants within a location in the virtual document, which is now
called “Moving and reordering descendants”

— Annotating PDF Documents

— Formatting the content in a form

— The rich text editor toolbar (collaboration services)

— Viewing workflows

— Viewing audit events

— Icons common to WDK applications
• Removed the following sections:

— Moving a descendant to another location in the virtual document

— Editing an alias set in a workflow
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Web Publisher documentation corrections

This section lists features that are updated or new for the localized documentation. The
Web Publisher user guide was localized for 5.3 SP1 but not for 5.3 SP2.
• Added the following sections:

— Jumping to an item in a list

— Selecting which columns appear in a list

— Using thumbnails as a visual cue

— Dragging and dropping

— Choosing an item on a selection page

— Opening a new window

— Viewing your WDK-app product information
• Modified the following sections:

— Setting author and developer preferences

— Creating new content for a web page

— Properties overview

— Creating a new taxonomy

— Creating a new category

— Creating a new workflow template

— Making a workflow template available

— Accessing site management

— Using the Rules Editor

— Creating and Managing Multi-Language Websites

— Using iMarkup

— Viewing system information and accessing Documentum tools

— Setting author and developer preferences

— Working with Relationships

— Working with Replicas
• Removed the following sections:

— How Taxonomies Work in WDK Applications

— Using Taxonomies in Web Publisher
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— Publishing Taxonomies to Web Sites

— Overview of Workflow Templates

— Restarting a Change Set

— Custom Dynamic Performer Values

— Simple Process Workflows

— Translation Workflows

— Workflow Tasks

— Workflow Methods

— Enabling Workflow Templates

— Working with Relationships and Replicas

Digital Asset Manager documentation corrections

This section lists features that are updated or new for the localized documentation.
• Modified the following information to include changes such as modified sentences,

and minor changes to steps in procedures due to UI or functionality changes:

— Setting File Share Services Preferences

— Publishing a course

— Ordering the contents of a Collection
The Webtop documentation changes are applicable to Digital Asset Manager. Please
refer to Webtop documentation corrections, page 74 for a list of Webtop documentation
changes.
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Chapter 8
Software Media, Organization, and Files

This section describes the media in which the software is available, the organization of the product
components in the available media, and the file names for all available product components which
can be downloaded.

Software Media
This product is available as an FTP download from the Downloads area of the
CustomerNet support site (http://softwaresupport.emc.com/support). You should have
received instructions through email regarding how to download products.

Organization
The Downloads area of the CustomerNet support site provides a complete listing of
products available for download. The Get Products tab takes you to the Download
Center page containing all the product downloads comprising language packs for
your application. Click Download ESG Products and select the correct language pack
for your application for example, Documentum Webtop Language Packs. Clicking
the language pack link enables you to download either Language Pack Manager or a
language pack for your specific language.

Files
The following modules\files comprise the contents of this release:
• Language Pack Manager

— Documentum Language Pack Manager, Version 5.3 SP2
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• Application language packs

— Documentum Webtop Language Packs, Version 5.3 SP2

— Documentum Application Connectors Language Packs, Version 5.3 SP2

— Documentum Web Publisher Language Packs, Version 5.3 SP2

— DocumentumWeb Development Kit for Portlets Language Packs Version 5.3 SP2

— Documentum Digital Asset Manager Language Packs, Version 5.3 SP2

— Documentum Compliance Manager Language Packs, Version 5.3 SP2
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Chapter 9
Installation

This section contains instructions for downloading Language Pack Manager, and downloading and
installing language packs for the following WDK-based applications:
• Webtop
• Application Connectors
• Web Publisher
• Digital Asset Manager (DAM)
• Web Development Kit for Portlets
• Web Publisher Portlets

Web Publisher Portlets installation is not supported for 5.3 SP2.
• Business Process Manager
• Documentum Compliance Manager
• Documentum Submissions Manager
• Documentum Client for Outlook
If your system meets the requirements listed in Chapter 4, Environment and System Requirements,
you are ready to install the software.

For information on core English application installations refer to the English installation guides;Web
Development Kit and Applications Installation Guide.

Note: You must ensure you have the correct WDK-based application versions to go with your
platforms. Refer to the English release notes for your WDK-based application for version details
before you install your language pack.

To download Language Pack Manager:

1. Download the Language Pack Manager (LPM) executable (for example,
LanguagePackManagerWin.exe or LanguagePackManagerSol.bin) from the
Documentum download site (https://documentum.subscribenet.com) to a convenient
directory on your application server host. This should be the same machine to which
you are installing language packs.
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If you cannot locate your password for the download site, use the password finder
on the bottom of the download page. Use your email address as your user name.

Once you have downloaded LPM you can download and install language packs. The language pack
installs language specific files that consist of graphical user interface and online Help that has been
localized (translated) into a language other than the default language, which is US English. You must
have your application server and the core Documentum product installed before you can install a
language pack.

The version of the language pack must match the major version label of the core Documentum
product. See Table 1–1, page 10 for details on language packs.

If you are installing language packs to the IBM WebSphere application server, or the SunONE
application server on UNIX, you must run Language Pack Manager as the installation root.

To install language packs for your WDK-based application using Language Pack Manager on all
operating systems following the procedure below. To manually install language packs on all
operating systems follow To manually install language packs:, page 82.

To install language packs using the installer:

1. Download the language pack zip file product_Language_Pack_language_locale_
version.zip, for example Webtop_Language_Pack_German_de_DE_5.3.0.x.x.x.zip,
from the Documentum download site (https://documentum.subscribenet.com) to the
same directory on your application server host where you downloaded LPM.
If you cannot locate your password for the download site, use the password finder
on the bottom of the download page. Use your email address as your user name.

2. If you are running Web Publisher and you have installed Content Server and the
application server on the same machine to which the language packs are being
installed follow these steps. Otherwise, skip to Step 3.

a. Stop Content Server.
Refer to Content Server Installation Guide for details.

b. Stop the Documentum Java Method Server.
• On Windows, if you have set up the method server to run as a Windows

service select Start→Settings→Control Panel→Services→Documentum
Java Method Server and click Stop.

• On UNIX, issue this command: shutdown.sh in $DM_HOME/tomcat/bin/

3. Double-click the LanguagePackManagerWin.exe file for a Windows install, or
execute the LanguagePackManagerSolaris.bin file for a Solaris install.
The Language Pack Manager welcome screen opens, displaying LPM version
information.

4. Click Next.

5. Select the radio button to agree with the licensing terms, then click Next.
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The Language Pack Manager welcome screen displays supported Documentum
product information and third party application server information. The product
information list displays all products supported in this and previous releases.

Note: Language Pack Manager is backwards compatible with all WDK-based
applications except portlets. Language Pack Manager 5.3 SP1 is NOT backwards
compatible with 5.2.x Web Development Kit for Portlets or Web Publisher Portlets.

6. Click Next.

7. Select the radio button to install language packs, then click Next.

8. If required, change the directory location for the language pack zip files, then click
Next.
For some products such as WDK for Portlets you must manually enter the directory
location for the language packs, and then click Next.
Refer to the Language Pack Manager online Help for details on the correct
installation location for each portal server
If LPM is in the same directory as your language pack zip files then you will not
need to enter a directory location. If you enter a directory location that does not
contain language pack zip files you will not be able to continue. Please ensure that
the directory you enter contains language pack zip files.

9. Select the Documentum product type from the list and click Next.
The product list is based on the language packs available in the directory selected.
If a language pack exists in the directory structure for a LPM supported product
the product displays in the list.
Please ensure that the core Documentum product onto which you want to install a
language pack exists on your machine.

10. Select the Documentum product instance, then click Next.
You can only install language packs to one instance at a time.
If Language Pack Manager does not automatically detect a product instance then
you can manually locate a product instance.

11. Select the language packs from the list and click Next.
You can select multiple language packs to install to the core product.

12. You are prompted to ensure the application server you are installing the language
pack(s) to is stopped.

13. Click Next.

14. Confirm the final installation settings and click Next.
If you experience any slow down, or suspected hang during installation, stop the
installation, delete the log.txt file located in $DOCUMENTUM (the log.txt file size
may be quiet large) and begin the install again.
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15. Click Finish.
Language Pack Manager closes.

Note: You can determine which language packs you currently have installed to
a machine by running the remove program and quitting once you have read the
version information on the Select the language packs to remove screen.

To manually install language packs:

1. Download the language pack zip file product_Language_Pack_language_locale_
version.zip, for example Webtop_Language_Pack_German_de_DE_5.3.0.x.x.x.zip,
from the Documentum download site (https://documentum.subscribenet.com) to
a temporary directory.
If you cannot locate your password for the download site, use the password finder
on the bottom of the download page. Use your email address as your user name.

2. Unzip the language pack to a temporary directory.

3. Stop your application server.

4. Copy the extracted files from the temporary directory to
.../Application Module
Click Yes to overwrite the existing files.

5. Navigate to
.../Application Module/WDK Application Folder Name
where WDK Application Folder Name could be wdk or wp.

6. In a text editor, open the app.xml file and uncomment the required language under
<Supported Locales> for example,
<!-- <locale>de_DE</locale> -->
should be uncommented to
<locale>de_DE</locale>

7. Restart the application server.

Repackaging the wcm.jar le for Web Publisher
If you have manually installed language packs for Web Publisher you must repackage
the wcm.jar file before copying the wcm.jar file from the application server machine
to the Content Server machine.

1. Stop the application server.

2. Navigate to $DOCUMENTUM/shared/dfc

3. Create a backup of the wcm.jar file and then extract the wcm.jar file.
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4. Copy the files from the /com folder, which you extracted into your
temporary directory, into the structure extracted from the wcm.jar file
(/com/Documentum/wcm/resources).

5. Repackage the wcm.jar file with the new files copied from the /com folder.

6. Copy the repackaged wcm.jar file into $DOCUMENTUM/Shared/dfc

7. Restart the application server.

Copying the wcm.jar le for Web Publisher
If your Documentum product is Web Publisher and your Content Server and application
server are on different machines you need to copy the wcm.jar file from the application
server machine to the Content Server machine. Web Publisher uses the wcm.jar file to
display localized Content Server messages. The language pack installer updates the
wcm.jar file on the application server but not on the Content Server.

To copy the wcm.jar le:

1. Stop the dm_method server.
You can only stop the dm_method server by stopping Content Server. Refer to
Content Server Installation Guide for details.

2. Stop the repository service.
• OnWindows, click Start→Documentum→Server Manager, select the repository,

and click Stop.
• On UNIX, run the dm_shutdown_repository script in the $DOCUMENTUM/dba

directory, where repository is the name of the repository to be stopped.
3. If required, stop your application server.

Refer to your application server documentation for further details.

4. Copy the wcm.jar file from the application server to Content Server.
• On Windows, copy from Program Files\Documentum\Shared\ on the

application server to Program Files\Documentum\Shared\ on Content Server.
• On UNIX, copy from $DOCUMENTUM_SHARED\dfc on the application server

to $DOCUMENTUM_SHARED\wpserverfiles on Content Server.
5. Restart the dm_method server.

You can only start the dm_method server by starting Content Server. Refer to Content
Server Installation Guide for details.

6. Restart the repository service.
• OnWindows, click Start→Documentum→Server Manager, select the repository,

and click Start.
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• On UNIX, run the dm_start_repository script in the $DOCUMENTUM/dba
directory, where repository is the name of the repository to be started.

7. If required, restart your application server.

Repackaging the dcm.jar le for Documentum
Compliance Manager

If you have manually installed language packs for Documentum Compliance Manager
you must repackage the dcm.jar file before copying the dcm.jar file from the application
server machine to the Content Server machine.

1. Stop the application server.

2. Navigate to $DOCUMENTUM/shared/dfc

3. Create a backup of the dcm.jar file and then extract the dcm.jar file.

4. Copy the files from the /com folder, which you extracted into your
temporary directory, into the structure extracted from the dcm.jar file
(/com/Documentum/dcm/resources).

5. Repackage the dcm.jar file with the new files copied from the /com folder.

6. Copy the repackaged dcm.jar file into $DOCUMENTUM/Shared/dfc

7. Restart the application server.

Copying the dcm.jar le for Documentum
Compliance Manager

If your Documentum product is Documentum Compliance Manager and your Content
Server and application server are on different machines you need to copy the dcm.jar
file from the application server machine to the Content Server machine. DCM uses the
dcm.jar file to display localized Content Server messages.

To copy the dcm.jar le:

1. Stop the Java method server.
You can only stop the Java method server by stopping Content Server. Refer to
Content Server Installation Guide for details.

2. If required, stop your application server.
Refer to your application server documentation for further details.
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3. Copy the dcm.jar file from the application server to Content Server.
• On Windows, copy from Program Files\Documentum\Shared\ on the

application server to Program Files\Documentum\Shared\ on Content Server.
• On UNIX, copy from $DOCUMENTUM_SHARED\dfc on the application server

to $DOCUMENTUM_SHARED on Content Server.
4. Restart the Java method server.

You can only start the Java method server by starting Content Server. Refer to
Content Server Installation Guide for details.

5. If required, restart your application server.

Installing Application Connectors
Application Connectors install within the content authoring application and present
WDK components within a native modal dialog window that hosts a browser control.
While the components can be from Webtop or a custom application, the modal dialog
window does not display the frameset of Webtop or other WDK client application.

The Application Connectors installer runs on the client in one of two ways:
• GUI installation:

The user is notified of the availability of Application Connectors. The user enters the
URL to the installer, which is part of the WDK application.

• Command-line installation:

SMS can be used to push out application connectors or Microsoft Office users with
an MSI-based installer. The command-line installation is outlined below

Application Connectors work with UCF content transfer only. If your application uses
custom content transfer components that extend WDK 5.2.5 components, Application
Connectors are not supported.

The installers will disable Documentum Desktop Office integrations before installing
5.3.x Application Connectors. Desktop Office application integrations are disabled by
removing relevant add-in files and registry entries.

The installer, Documentum-AppConnectors-5.3.x-Client.exe, verifies that OS and content
authoring application are present in the correct versions, that the user is designated
a power user or administrator in the users control panel, and there is sufficient disk
space. Supporting Windows software such as .NET is installed if not present. The
client software footprint is approximately 5 MB, with an additional 25 MB for the .NET
framework if it is not already present on the client.
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Location of Installed Files - The installer places files in the following locations. The
variable %PROGRAMFILES% is the path to the Program Files directory on the client
machine.

Table 9-1. Location of les installed on the client by Application Connectors

File type Location under %PROGRAMFILES%

Files used by all Application Connectors \Documentum\AppConnector

Files used by a specific Application
Connector

Application root directory, for example:
\Microsoft Office\OFFICE{10, 11}

Menu for a Webtop 5.3 application %PROGRAMFILES%\Microsoft
Office\OFFICE{10, 11}\Documentum and
subdirectory app_name where app_name
must match a value in the app.config files

Location of files used by the localized
Application Connectors (satellite resource
assemblies)

%PROGRAMFILES%\Documen-
tum\AppConnector\<locale>
%PROGRAMFILES%\Microsoft Of-
fice\OFFICE{10, 11}\Documentum\
<locale>

For details on GUI Installation and command line installation of Application Connectors,
refer to Chapter 9 ofWeb Development Kit and Application Installation Guide.

Uninstalling language packs
This section contains instructions for uninstalling language packs for supported
WDK-based applications.

If you remove all language packs you must clear your browser cache and cookies from
your machine to remove the last language settings from your cache.

You only need to remove language packs to remove language support. You can install
new language pack versions on top of an existing installation following the steps in
To install language packs using the installer:, page 80. You do not need to remove an
existing 5.2.x versions before reinstalling the same or installing an updated version.

If you are removing language packs from the IBMWebSphere application server, or the
Sun ONE application server on UNIX, you must run Language Pack Manager removal
as the installation root.

To uninstall language packs for your WDK-based application on all operating systems
following the procedure below. To manually uninstall language packs all operating
systems follow To manually remove language packs:, page 88.
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Note: If you manually modified the app.xml file to support a language for which you
did not create a language pack you can still use the removal procedure below. The
removal procedure will work as long as you correctly added the locale entry to the
app.xml file. For more details on manually modifying the app.xml for your locale refer,
Web Development Kit Applications Localization Guide.

To remove language packs using the uninstaller:

1. If you are running Web Publisher and you have installed Content Server, the
application server, and the language packs to the same machine following these
steps. If you are not running Web Publisher start with Step 2.

a. Stop Content Server.
Refer to Content Server Installation Guide for details.

b. Stop the Documentum Java Method Server.
• On Windows, if you have set up the method server to run as a Windows

service select Start→Settings→Control Panel→Services→Documentum
Java Method Serverand click Stop.

• On UNIX, issue this command: shutdown.sh in $DM_HOME/tomcat/bin/
2. Double-click the LanguagePackManagerWin.exe file for a Windows uninstall, or

execute the LanguagePackManagerSolaris.bin file for a UNIX uninstall.
The Language Pack Manager screen opens, displaying LPM version information.

3. Click Next.

4. Select the radio button to agree with the licensing terms, then click Next.
The Language Pack Manager screen displays LPM version information.

5. Click Next.

6. Select the radio button to remove language packs, then click Next.

7. Select the radio button for one of the Documentum product types to remove and
click Next.

8. Select the radio button for the Documentum product instance, then click Next.
You can only remove language packs from one instance at a time.

9. Select the language packs to remove from the list and click Next.
You can select multiple language packs to remove.

10. You are prompted to ensure the application server you are removing the language
pack(s) from is stopped.

11. Click Next.

12. Confirm the final removal settings and click Next.
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If you experience any slow down, or suspected hang during uninstall, quit the
unistall, delete the log.txt file located in $DOCUMENTUM (the log.txt file size may
be quiet large) and begin the uninstall again.

13. Click Finish.
Language Pack Manager closes.

To manually remove language packs:

1. Stop the application server.

2. On your installation machine, navigate to
.../Application Module

3. Delete the Help/(Language_Code) folder and contents.
Where (Language_Code) is the language_pack you want to remove.

4. Locate the following property files: Application Module/* Language_Code.properties
that is, every file that contains language codes in its name for example,
FrameTitleNlsProp_fr_FR.properties.

5. Delete all the files found in the previous step.

6. Navigate to
.../Application Module/WDK Application Folder Name
where WDK Application Folder Name could be wdk folder or wp folder.

7. In a text editor, open the app.xml file and remove the Language under
<supported_locales> for example, <!-- <locale>fr_FR</locale> --> should be removed
for french.

8. Restart the application server.
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Chapter 10
Troubleshooting and Getting Help

Documentum’s technical support services are designed to make your deployment and management
of Documentum products as effective as possible. The Customer Guide to Support Services provides
a thorough explanation of Documentum’s support services and policies. You can download this
document from the CustomerNet support site (http://softwaresupport.emc.com/support)
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